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Desarrollo de software para sistemas 
embebidos
Software Tradicional

Se desarrolla, depura y ejecuta en la misma
estación de trabajo.

Un sistema operativo de alto nivel carga el
programa en memoria cuando va a ejecutarlo.

Se utiliza memoria virtual, la traducción de
memoria virtual a física la hace el procesador.

El programa al finalizar devuelve el control al
sistema operativo.

Software para sistemas embebidos

Se desarrolla en una estación de trabajo y se
ejecuta en un dispositivo de computo que
puede tener otra arquitectura. La depuración
se hace en parte en la estación de trabajo y en
parte en el dispositivo que ejecutará el
software.

No hay división sistema operativo/aplicación,
se utiliza una imagen ejecutable que contiene
todo el software (Boot, Rtos, Aplicación, ISR,
controladores, etc).

Se utiliza solo memoria física.

El software de aplicación no tiene un punto
de finalización.
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Ciclo de desarrollo utilizando SDK
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Entorno: Workspace y Perspectivas
Workspace:
Es el repositorio físico de los proyectos y donde se guarda la configuración general.
Normalmente solo se utiliza un workspace con varios proyectos
Si se tiene distinto hardware, conviene definir un workspace propio para cada uno

Vistas y Editores:
Son los elementos donde se desarrolla el proyecto: en los editores se trabaja código (normalmente en

lenguaje C) y en las vistas se ve información del software a través de interfaces gráficas.

Perspectivas:
Son un conjunto de vistas y editores cuya funcionalidad esta relacionada (p.ej. Depuración)
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Vista C/C++ Project
Muestra los proyectos dentro del workspace
en forma jerárquica

Se accede a cada archivo en forma directa
(doble click sobre el archivo)

Se puede acceder a la configuración de cada
proyecto en forma directa (click derecho sobre
el proyecto)

Software 
Applications

Hardware 
Description

Software 
BSP

Software 
Applications
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Vista Outline
Muestra la estructura del archivo abierto en
el editor.

El contenido de la vista depende del editor
que se esta utilizando.

Se identifica el tipo de contenido mediante
iconos.

Ejemplo: en un archivo de C los iconos representan
o Sentencias #define
o Archivos cabecera (.h)
o Prototipos de funciones
o Definición de funciones (cabecera + cuerpo)

Seleccionar un elemento en la vista permite
navegar al mismo elemento en el editor.
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Perspectiva C/C++
Elementos:

Vista Project: muestra los archivos del 
proyecto identificando con iconos cada tipo 
de archivo

 Vista Outline: muestra elementos del 
archivo actualmente en el editor de código

Editor de código: Orientado a C/C++ con 
resaltado de texto

Vistas Console, Problems: muestran 
información de compilación

Project View

Editor 
View

Code 
Outline

Consola
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Acceso a Vistas y Perspectivas
Perspectivas
oMenu Window -> OpenPerspective

Vistas
oMenu Window -> Show View
o Si la vista esta presente en la perspectiva actual, 

quedará resaltada
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Iniciar la herramienta SDK
En forma independiente 
o Permite especificar el workspace
o Permite especificar la plataforma de hardware a utilizar

Desde la herramienta Vivado
o Exportar el hardware (Menu File -> Export Hardware) para especificar la plataforma de hardware 
o Iniciar la herramienta (Menu File -> Launch SDK)

En ambos casos:
o La plataforma de hardware se describe mediante un archivo HDF (Hardware Description File)
o Se genera un proyecto Hardware Platform Specification en forma automática
o Adicionalmente se puede crear un proyecto BSP (board support package) y un proyecto de aplicación 

asociados a la plataforma de hardware
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Proyecto BSP
Este proyecto contiene todo el middleware
(controladores de periféricos y RTOS) necesarios
para trabajar con el sistema descripto en la
plataforma de hardware.

No incluye los controladores asociados a IP
Propia en el hardware. Estos controladores están
en el proyecto Hardware Platform Specification,
junto con el software de inicialización necesario
para configurar el hardware.

Siempre tiene asociado un proyecto Hardware
Platform Specification

Se puede crear en forma independiente o
cuando se crea un proyecto de aplicación
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Proyecto de Aplicación
Un proyecto de Aplicación siempre tiene asociado un proyecto BSP

Puede haber varios proyectos de aplicación asociados al mismo
proyecto BSP

Hay disponibles plantillas con proyectos de aplicación básicos para
verificar la funcionalidad de los periféricos y como base para
desarrollar aplicaciones propias.

Opcionalmente se puede crear un proyecto vacio (Empty
Application) para desarrollar una aplicación propia desde el principio.

Estos proyectos pueden tener distintas configuraciones
o Debug: Para depuración (configuración por defecto)
o Release: Codigo de Producción
o Profile: Para medición de tiempos de ejecución
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Ciclo de Desarrollo
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Herramientas: GCC
GCC es el compilador de código fuente en lenguaje
C a assembler del procesador (ARM)

Tambien es la interfaz a otras herramientas (GNU
Assembler – GAS y GNU Linker – Ld) invocándolas
con los parámetros apropiados.

Es un compilador cruzado (cross compiler), se
ejecuta en una arquitectura x86_64 y compila a una
arquitectura ARM32

Es una herramienta de línea de comandos que se
invoca con parámetros configurados dentro del
entorno.
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Herramientas: GCC
Es la interfaz para estas herramientas:

Preprocesador (cpp0): Reemplaza las etiquetas
por sus definiciones en código fuente y cabeceras

Compilador
o Cc1: compilador de C
o Cc1plus: compilador de C++

Assembler (arm-xilinx-eabi-as): compila el
assembler generado a código objeto

Enlazador (arm-xilinx-eabi-ld): resuelve las
direcciones de memoria del código objeto e
integra todos los archivos de código objeto en
una imagen ejecutable.
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Herramientas: AS
Es el compilador de assembler a código
objeto

El código objeto contiene:
o Código de máquina de las instrucciones
o Constantes
o Referencias externas
o Información de depuración
o Direcciones de memoria relativas
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Herramientas: LD
Integra los distintos archivos de código objeto 
en una imagen ejecutable

Utiliza un archivo linker script para resolver la 
ubicación en memoria de los distintos elementos

Genera una imagen ejecutable en formato .ELF

Genera un mapa de memoria con la ubicación 
de cada elemento del software (constantes, 
variables, estructuras, funciones, etc) 
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Herramientas Auxiliares
Archiver (ar)
o Crea, modifica y extrae código objeto de librerías
o Integra el código objeto del proyecto BSP asociado en una librería del proyecto de aplicación

Object Dump (objdump): Muestra información de archivos objeto e imágenes ejecutables
o Arquitectura para la que se compilo el código
o Ubicación en memoria de los distintos elementos
o Código desensamblado
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Herramienta Object Dump
Información de las distintas secciones: arm-xilinx-eabi-objdump –h <imagen ejecutable>.elf
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Herramienta Object Dump
Código fuente y código desensamblado: arm-xilinx-eabi-objdump –S <imagen ejecutable>.elf
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Servicios mínimos
El software de sistema (middleware) debe proveer distintos servicios para que el software de
aplicación pueda ejecutarse

Servicios standard del lenguaje C
o Stdin y Stdout
o Librerias (math, stdlib, conio, etc)
o Gestion de memoria dinámica (malloc, free)

Servicios de soporte al procesador
o Gestión de interrupciones
o Inicialización
o Acceso al hardware (p.ej. Temporizador Interno)
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Sistemas Operativos
El sistema operativo es un software de sistema que permite ofrecer al software de aplicación
un conjunto standard de servicios (acceso a hardware, almacenamiento permanente, interfaces
de entrada y salida, etc)

Si no se utiliza un sistema operativo (configuración standalone/bare metal), el software de
sistema provee un conjunto mínimo de estos servicios a través de funciones.

Se pueden configurar distintos sistemas operativos:
Linux (sistema operativo de alto nivel)
FreeRTOS (sistema operativo de bajo nivel con requerimientos de tiempo real)
XilKernel (sistema operativo básico)

El sistema operativo forma parte del software de sistema y forma parte del Proyecto BSP
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Sistemas Operativos
Los sistemas operativos facilitan la provisión de servicios al software de aplicación

Interfaz gráfica

Conectividad (ethernet, wifi, TCP/IP)

Gestión de Tareas/Aplicaciones

Gestión de recursos de hardware

Comunicación entre aplicaciones

Lanzamiento, ejecución y finalización de aplicaciones

Gestión de sistemas de archivos (almacenamiento permanente)
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Configuración Standalone / Bare Metal
Esta configuración es recomendable cuando:

Todos los servicios necesarios pueden incluirse en el Proyecto BSP

La aplicación es estática (no es necesario reiniciarla)

La imagen ejecutable puede ubicarse en BlockRAM, OnChip RAM o DDR RAM

La aplicación consiste en una sola tarea

Esta configuración permite la gestión de interrupciones a través de llamadas a función
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Configuración Standalone / Bare Metal
La configuración se accede desde el menú
Xilinx -> Board Support Package Settings

En la opción “Standalone” se puede
seleccionar los servicios que van a estar
disponibles para la aplicación desde el
software de sistema.

Por cada servicio disponible se genera una
subentrada dentro del menú “Standalone”
que permite configurar el software de ese
servicio.
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Generación de las librerias
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Generación de las librerias
La herramienta libgen genera el software de sistema disponible para las aplicaciones

Toma información del archivo .MSS, que define los controladores asociados a periféricos, los
dispositivos stdin y stdout y demás características del software de sistema

Genera las librerías que utilizará la aplicación
o libc.a: Librería standard de C con las funciones del lenguaje
o libXil.a: librería con los controladores de los periféricos
o libm.a: librería para soporte de funciones matematicas
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Configuración de las opciones de 
compilado
El compilador se invoca mediante una
línea de comando cuyos parámetros se
pueden configurar desde las opciones del
proyecto

Hay 3 configuraciones por defecto
(debug, reléase, profile). Cada una de
ellas tiene un juego de parámetros
específicos para cada herramienta del
proceso de compilado

Es posible generar configuraciones
personalizadas
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Configuración de las opciones de 
depuración y optimizado
Nivel de optimización:
o None
o Low
oMedium
o High
oOptimizado para tamaño (código mas

compacto)

Nivel de información de depuración:
o Necesario para poder depurar, pero genera

una imagen mas grande y lenta
o Es conveniente fijar el nivel de optimización

en “None” para depurar
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Configuración de símbolos para 
compilado condicional
Se puede agregar, editar o borrar símbolos

Se utilizan de la siguiente forma:

#ifdef <símbolo>

(código compilado condicionalmente)

#endif

En la línea de comando corresponden a la
opción “-D”
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Configuración del Enlazado
Se puede configurar el nombre del
archivo de enlazado y las librerías con
las que se enlazara el código de la
aplicación.

En general no es necesario variar esta
configuración
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Gestión de Direcciónes de Memoria
En el PS el procesador tiene asignados
determinados espacios de memoria para
funciones específicas, por lo que es necesario
definir:

Ubicación y rango de direcciones de los
periféricos

Ubicación y rango de los bloques de
memoria de código (BlockRAM, Flash, DDR,
etc)

Asignación de memoria del procesador:
o 1 GB: DDR RAM
o 2 GB: Periféricos en PL (IP Propia)
o 1 GB: Periféricos en PS
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Espacio de memoria del bloque PL
Espacio total de 2 GB

1 GB para cada Maestro AXI (GP0 y GP1)
Según el GPx al que este conectada la IP Propia es el

rango de direcciones disponible.

Espacio accesible por los periféricos AXI Maestro
o Procesadores ARM Cortex A9
o Controlador DMA
o Periférico ethernet
o Periférico USB
o Periférico SD/SDIO
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Espacio de memoria de los periféricos PS
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Espacio de memoria de los registros de 
control de sistema (SLCR)
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Espacio de memoria de los registros del 
bloque PS
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Espacio de memoria de los registros 
internos de los CPU
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Archivo objeto
Un archivo objeto es código ensamblado, es decir código de maquina

li r31,0x00   0x3BE0 0000

Además puede contener:
Constantes
Referencias a elementos que están definidos en otros archivos objeto
Información de depuración
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Secciones del archivo objeto
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.text

.rodata

.data

.bss

Text section (codigo)

Read-only data section (constantes)

Read-write data section (variables inicializadas)

Uninitialized data section (variables no inicializadas)

int ram_data[10] = {0,1,2,3,4,5,6,7,8,9};       /* DATA */

const int rom_data[10] = {9,8,7,6,5,4,3,2,1};   /* RODATA */

int I;   /* BSS */

main(){

...

I = I + 10;  /* TEXT */

...

}
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Linker script
El archivo linker script (lscript.ld) controla el proceso de enlazado de todos los archivos objeto

Establece la ubicación dentro del mapa de memoria del código y los datos

Define el punto de entrada de la imagen ejecutable

Reserva espacio para el stack.

Es necesario si el mapa de memoria no es continuo
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Enlazado
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Generación del linker script
Se configura mediante una
interfaz gráfica en formato de
tabla

Se inicia desde el menú Xilinx
-> Generate Linker Script
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Practica 4
En esta Práctica se utiliza el
hardware creado en la práctica
anterior.

Se creará una aplicación de
software que utilizará un
controlador (driver) para
comunicarse con la IP Propia.

Se modificará el linker script
para asignar distintas zonas de
memoria a las secciones de la
aplicación.
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